
Ayuda, Soporte y configuracion Echolink 
 

Este software fue diseñado por Jonathan Taylor K1RFD en el año 2001, el mismo se encarga de utilizar el protocolo voIP 
para realizar comunicaciones entre radioaficionados. Posee caracteristicas interesantes: 
 
. Seguridad ( Uso exclusivo para radioaficionados). 
. Conexión estable. (por UDP).  
. Control por tonos DTMF.  
. Buena calidad de audio. 
. Servidor web de control, reporte del link por sistema APRS. 
 
Respecto a las versiones, solo existe una versión de Echolink, que según como se configure funcionara como link o 
estación terminal. 
 
La pueden descargar desde el sitio de ARGCONF o bien desde la pagina oficial : http://www.echolink.org  
 
Prerrequisitos: 
 
1) Se requiere para el funcionamiento del programa habilitar los puertos  5198, 5199 UDP y 5200 TCP si se posee un 
firewall, si desea instalar el software en otra maquina distinta de la que tiene conexión a internet estos puertos deberan 
ser ruteados a la misma. 
 
http://www.echolink.org/Help/firewalls.htm (Informacion sobre como configurar estos pasos.) 
 
2) Para empezar a usar el software es necesario enviar un correo electronico a validation@echolink.org  una captura 
digital del documento que lo avala como radioaficionado en su pais. 
 
Antes que nada, Definamos algunos terminos importantes. 
 
Enlace: Unir el equipo de radio con la pc por medio de una interface + el software. 
 
Interface: Circuito electrico básico que interpreta las acciones del software y las traslada al equipo de radio. 
 
Link: Enlace que se genera en una frecuencia Simplex. Entrada y Salida por la misma frecuencia. En el programa se 
especifica con la letra –L después del indicativo. 
 
Repetidora: Enlace que se realiza con una repetidora . Donde la frecuencia de Salida no es la misma que la de entrada. 
En el programa se especifica con la letra –R después del indicativo. 
 
Crosslink: Enlace que se efectua entre dos programas distintos que tienen un mismo fin. 
 
Password: Contraseña de acceso.  
 
Server: Servidor. 
 
Monitor: Estación que siempre esta escuchando la actividad en el room y efectua las respectivas grabaciones y 
auditorias del servidor.  
 
Conferencia: Servidor dedicado de gran velocidad donde se conectan varias estaciones simultáneamente. 
 
Nodo: Se le define a las estaciones activas en el programa. Todas tiene un numero designado por los administradores 
de Echolink. 
 
- ¿Qué hay que tener en cuenta al enlazar el equipo de radio? -  
 
Existen ciertos aspectos que hay que tener en cuenta al instalar un enlace. 
 

1) Tratar de hacer respetar ‘insistentemente’ los tiempos entre cambio y cambio. 5 a 7 segundos.  
2) Establecer un tiempo de transmisión por cambio. 3 minutos. 
3) Tratar de evitar enlazar a un repetidor con mucho trafico local. 
4) Si se enlaza un sistema repetidor, tener el consentimiento del titular. 
5) Tratar de establecer una frecuencia y tipo de subtono para evitar interacciones e interferencias. 
6) Hacerse responsable del mantemiento del enlace. Y guiar a estaciones que comienzan a experimentar. 
 

http://www.echolink.org/
http://www.echolink.org/Help/firewalls.htm
mailto:validation@echolink.org


Ventana Principal  
 

 
Figura 1.1 – Ventana principal. 

 
Esta es la ventana principal del Echolink. La analizaremos por partes. 
 

 - Menu principal.  
 
Menu File > 
 

1) Print: Va a las opciones de impresión. 
2) Print Preview: Muestra como saldra la impresión 
3) Print Setup: Opciones de impresión.  
4) Profiles: Perfiles de usuario. 
5) Exit: Salida del programa. 

 
 

 
 

 
 
 
 
 
 
 
 
 



File > Profiles > 
 
                   Crea perfiles de usuario. 
 

1) OK: Guarda los cambios. 
2) Cancel: Cancela cualquier cambio. 
3) New: Opciones para crear un nuevo perfil. 
4) Delete: Borra perfiles. 
5) Help : Ayuda para la creación de perfiles. 
6) Always Start with selected profile: Elige que perfil cargue siempre 

al comenzar a usar la aplicación. 
 
 
 
 
 
 
 

 
 
Menu Edit > 
 

Opciones para copiar, cortar, pegar y borrar texto. 
 
 
 
 
 
 
 

 
 
Menu Station > 
 

 Opciones de Operación: 
 

1) Transmit: Inicia la transmisión , tecla de acceso rapido (BARRA 
ESPACIADORA) 

2) Connect: Conectar, luego de haber seleccionado una estacion. 
3) Connect to: Conectar a una estacion o nodo especifico. 
4) Connect to Test Server: Conectar al servidor de pruebas de audio. 
5) Reconnect: Reconectar a donde estaba conectado anteriormente. 
6) Disconnect: Desconectar de un nodo. 
7) Request Version: Pedir la version del software del nodo a donde esta 

conectado. 
8) Info: Muestra la información del nodo donde esta conectado. 
9) Find: Buscar a un nodo especifico. 
10) Refresh List: Refresca la lista de nodos, estaciones. 

 
 

------------------------------------------------------------------------------------------------------------------------------------------------------------------ 
 
 
 
 
 
 
 
 
 
 
 
 



 
Menu Tool > 
 

Opciones de Configuración: 
 

1) Alarms: Especifica alarmas de aviso cuando se conecta un determinado 
Nodo al sistema. 

2) List Me as Busy: Muestra a los demas usuarios que nuestra estacion esta 
ocupada. 

3) Disable Link: Deshabilitar el enlace. 
4) Listen-Only Mode: Modo solo escucha, permite escuchar pero no transmitir. 
5) Setup: Opciones. 
6) Preferences: Preferencias 
7) Sysop Settings: Opciones de sysop , solo para cuando se conecte un link. 
8) Link Setup Wizard: Ayuda rapida para configurar un link. 
9) Adjust Volume: Ajuste de volumen. 
10) Tone Generator: Generador de tono en una determinada frecuencia y 

amplitud. 
11) Start Recording: Comienza a grabar la actividad en el nodo. 
12) Play_Sound File: Reproduce un archivo de sonido. 
13) Stop: Para la reproducción del archivo de sonido. 
14) Pause Playback: Hace una pausa en la reproducción del archivo de sonido. 

 
 
Menu Tool > Setup 

 
Opciones de la estacion: 
 

1) Mode: Single User ( Usuario), Sysop ( Para 
conexión a equipo de radio). 

2) Callsign: Licencia de aficionado registrada. 
3) Password: Contraseña por usuario. 
4) Name: Nombre del enlace o nombre del titular de 

la estacion. 
5) Location: Ubicación geografica del enlace. 
6) Email Addr: Direccion de email del titular. 

 
  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 



Configuración de servidores de conexión: 
 

1) pref. 1,2,3,4,5: Direccion de los servidores de 
Echolink. Se determinan según la ubicación 
geografica de la estacion. 

2) Reset to Defaults: Vuelve a los servidores por 
defecto. Los elige según zona geografica de la 
estacion. 

3) Retry Timeout (sec): Tiempo de espera después 
de que un servidor no responde para intentar 
conectar a otro. 

4) Automatically Dial Connection: Marca 
automáticamente esta conexión cuando arranca el 
programa. 

5) Disconnect on exit: Desconecta cuando sale del 
programa. 

  
 
 
 
 
 
 
 
 
 
 
 
Configuración de tiempos de operación:  
 

1) Connect attempt: Intervalo entre intentos de 
conexión. 

2) Transmit time limit: Tiempo limite de t
Receive time

ransmisión. 
3)  limit: Tiempo de recepcion. 

ntes 

5) e: Tiempo de espera en la 
 

 

4) Inactivity timeout: Tiempo de inactividad a
de desconectar. 
Receive hang tim
recepcion luego de que la otra estacion deje de
transmitir. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 



Configuración de audio: 

1) Input Device: Dispositivo de sonido de entrada 

4)  Rate Compesation: Genera 
r 

5) o 300hz para la 

fonos 

6) ing Mode: Grabacion automatica por 

7) ontrola cuantos datos recibe 
xión 

8) uidos 

9) Total Audio Delay: Especifica el tiempo de 

-------------------------------------------- ----------- 
Menu Tools > Preferences 

onfiguración de listado de estaciones:

 

2) Output Device: Dispositivo de sonido de salida. 
3) Open in Full Duplex: Esta opcion se utiliza en el 

caso de que ocurra un error cuando se comienza 
a transmitir. 
Auto Sample
paquetes en forma dinamica para compensa
problemas de ruidos en el audio. 
300 Hz. TX High-Pass Filter: Filtr
TX, para evitar booms o pops del audio de 
ingreso, cosa que ocurre con algunos micró
de pc. 
Record
Licencia o Fecha, Carpeta donde se quiere 
guardar los archivos. 
Network Buffering: C
el echolink de internet, si la velocidad de cone
a internet es lenta es recomendable ubicar este 
parámetro todo a la derecha. 
PC Buffering: Controla cuantos datos seg
son enviados a la placa de sonido, si la maquina 
es vieja o tiene ejecutando muchas tareas es 
recomendable ubicar este control todo a la 
derecha. 

demora    entre que la otra estacion comience a 
transmitir.   
------------------

 
C  

1) Update station list automatically, Update every, 

o de 

2) iew: Permite elegir el tipo de 

3) as 

4) egar los nuevos 

5) n startup: 

 

 

 

Even while connected: Actualiza la lista de 
estaciones automáticamente, cada un interval
tiempo, seleccióna si lo hace simpre y cuando este 
conectado o no. 
Show in Index V
estaciones que queremos ver en la pantalla. 
Show Alarms in pop-up windows: Mostrar l
alarmas en una ventana saliente. 
Add new QSOs to Favorites: Agr
contactos a los favoritos. 
Restore window size and position o
Reestablecer el tamaño y la ubicacion en la lista 
cuando arranque el programa. 

 
 
 
 
 
 
 
 
 
 
 

 
 



Configuración de la conexión de estaciones:  

) Conferencing: Modo conferencia de estacion.  

confere
it to N other stations: Limita el numero de 

estacion

 la lista de 

 conexión de 

do la estacion este libre, no 
or 

n este ocupada. 
 

ile: Archivo de información de la 

te 

 
pciones de seguridad: 

1) Accept conns from: Aceptar conexión de los 

2) lo las 

3) staciones en la 

4) acional Prefixes: Acepta o deniega 

5) : Aplica seteos de 

d connectios request: Conexiones 

b. onnections attemps: 

 

 
1

a. Allow Conferences: Habilita el modo  
ncia. 
b. Lim
es que se pueden conectar simultáneamente. 

 c. Update Location entry with status:  Agrega 
despues de la descripción / ubicación la cantidad de 
estaciones conectadas a nuestra conferencia. 
 d. Send station list to all stations: Envia
conexión a todas las estaciones conectadas. 
 e. Allow multi-conferencing: Permite la
nuestra conferencia a otras. 
2) Location / Description 
 a. Free: Texto cuan
tenga conectada a ninguna estacion o una cantidad men
a la especificada en allow conferences. 
 b. Busy: Texto cuando la estacio
 c. Show name of conected conference: Muestra el
nombre de la conferencia donde estamos conectados. 
3) PTT Control: Elegimos con que tecla queremos 
controlar la transmisión. 
4) Station Information F
estacion . Selección con Choose y edicion con Edit. 
5) Show Alert when ‘Doubling’ : Alerta cuando exis
una sobremodulacion entre nuestra estacion y otra. 
 

 O
 

tipos de estaciones seleccionados. 
Accept only these calls: Aceptar so
estaciones que figuran en la lista. 
Deny these calls: Denegar a las e
lista. 
Intern
estaciones por su prefijo.  
Apply security settings to
seguridad a:  

a. Inboun
entrantes. 
Outbound c
Conexiónes salientes. 

 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 



Opciones de audio segun eventos : 

quí designamos que sonido reproducir para cada tipo de 

 
-------------------------------------------------------------------------- 

Menu Tools > Sysop Settings 

onfiguración de la deteccion de señal: 

 
A
evento que ocurra en el programa. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
C  

1) Carrier Detect: Configura la deteccion de 
erie. 
 

evitar el corte si se hacen pausas 

b.  un 
lch que ocurre 

c.  
el  

 
d.  com 

2) Squelc  se 
realiza u na repetidora, para evitar 

 
 

 
 

 

señal, manual , por VOX , Entrada puerto s
a. VOX Delay: Retardo del VOX para

largas durante la recepcion de 
estaciones locales. 
Anti-Thump:  Control para evitar
disparo falso de sque
comúnmente en las repetidoras. 
ClrFreq Delay: Demora de frecuencia
libre, tiempo de espera después d
corte del vox que el programa 
interpreta que la frecuencia esta libre.
Serial port: Determina el puerto
utilizado para ingreso de deteccion de 
squelch, como ocurre con algunas 
interfaces. 

h Crash Anti-Trip: Se utiliza cuando
n enlace a u

posibles disparos de squelch.  

 
 
 

 
 
 



Configuración de la activacion de PTT. 

para activar el 
PTT, por VOX externo, Interface especial, 

2) l PTT 
cuando se sale de la misma pc con 

 
 

onfiguración del control remoto del link por DTMF

 
1) PTT Activation: Tipo de medio 

Puerto COM. Selección del puerto de 
conexión. 
Key PTT On Local Transmit: Activar e
del equipo 
el micrófono de la misma. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
C  

do. 
tre 
zadas. 

3) rchivo todos 

6) 

l 

 
 
 

 
1) DTMF Decoder: Selección del tipo de 

decodificador , interno, externo o deshabilita
2) Min Interdigit Time: Tiempo minimo en

digitos para decodificar. Opciones avan
Log All Commands: Guardar en a
los movimientos por DTMF 

4) Auto Mute: Mutea automáticamente la entrada 
al programa al detectar una secuencia de 
tonos, con el fin de evitar desconectar otro link. 

5) Disable During PTT: Deshabilitar el decoder 
mientras el equipo este en transmisión. 
Enable Remote Pad: Permite habilitar un PAD 
para enviar tonos DTMF al link desde otra pc. 

7) Listado de cada una de las funciones, con la 
correspondiente secuencia para la accion. 

8) Dead-Key Prefix: Tono para iniciar la 
secuencia de tonos o desactivarla, se usa en e
caso de que una repetidora tambien tenga 
control por DTMF para que no haya conflicto. 

9) Station Shortcuts: Permite crear secuencias 
de acceso rapido a nodos especificos. 

 
 
 
 
 
 
 
 
 
 
 



Configuración de la identificación del enlace: 
 

1) Station identification: Tipo de identificación 
del enlace. 

enú 
settings se configura velocidad, tono y 

ken Voice: Voz digitalizada. 
o 

2)    Identify dor: 
mpre 

b. 
a estacion se 

c.  min: Al 

d. every NN min: Mientras 

e. 
o esta activo cada NN 

f. sperar a que 

 
Opciones de an

a. Morse: Por telegrafia., en el m

volumen. 
b. Spo
c. External file: Archivo de voz grabad

en formato Mono, 8-bit, 8000hz. 
: Identifica

a. Each time a station connects: Sie
que una estacion se conecte. 
Each time a station disconnects: 
Siempre que un
desconecte. 
At end of transmisión, every NN
final de la transmisión cada NN 
minutos. 
While Active, 
esta activo cada NN min. 
While not active, every NN min: 
Mientras n
minutos. 
Wait for clear frequency: E
la frecuencia este libre. 

uncios.  
 

1) Announ  conexión 
cuando se conecta por primera vez la estacion, 

tan todas las estaciones o 
 incluir o no el indicativo. 

a 

3) 

 

ce connects: Anuncia la

cuando se conec
nunca. Se puede

2) Announce disconnects: Idem 1 pero para l
desconexion. 
Announcement muting: En que momento 
silenciar el anuncion. 

4) Play welcome message to connecting 
station: Reproducir un mensaje de bienvenida 
cuando se conecta una estacion. 

5) Play courtesy tone: Reproduce un tono de 
cortesía . 

6) Play activity reminder every 120: Reproduce 
un tono para indicar a las estaciones que estan 
dialogando en forma directa que el link esta 
activo. 

7) Max key-down time: Tiempo maximo en que 
el transmisor quede en transmisión antes de 
desconectar de la estacion. Para deshabilitar 
=0 

8) Dead-carrier timeout: Tiempo de espera de 
desconexion si no se detecta alguna señal de 
audio de una estacion. 

9)  Announcement pre-delay: tiempo de espera   
antes de enviar el anuncio.  

 
 

 
 
 
 
 



Configuración de sonidos para eventos: 
 

1) Event: Lista de eventos con su 
correspondiente sonido. Se puede usar los que 

2) Speech Speed: Velocidad de la voz. 
do comienza 

gir 

 
 
 
 

onfiguración de control remoto via Web:

vienen por defecto o bien armarlo uno. 

3) Tone Burst: Envia un tono cuan
la transmisión o cuando una estacion se 
conecta. Es util para repetidoras que requieran 
para su ingreso este tono. Permite ele
frecuencia y duracion. 

 
 
 
 
 
 
 
 
 
 
 
 
C  

sta opcion permite controlar el sistema via remota 
esde cualquier lugar donde se tenga acceso a 

 contraseña. 

 
E
d
internet. Se establece un puerto , usuario y
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 



Configuración de reporte de la estacion via APRS, 
AVRS. 
 
Aquí se ingresan los datos del enlace, coordenadas, 

ecuencia, subtono, condiciones de trabajo. 

e ademas agregar un objeto en APRS 
onectando un TNC. 

        

       

 

---------------------------------------- ------------- - 
Menu Tool > Link Setup Wizard 
 

Presentacion del asistente. 
 

 

fr
 
Se pued
c
 
 
 
 
 
 
 
 
 
  
 
  
  
 
        
  
 
 
 
------- ----

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 



Seleccion del tipo de enlace que se desee 
efectuar, Repetidor ( 2 frecuencias), Link (1 
Frecuencia) 
 

 
ipo de interface que se utiliza y puerto 
onde esta conectada. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

T
d
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



Información del enlace. Coordenadas, 
Condiciones de trabajo. Etc. 
 
 

 
------------------------------------------------------ --------- 

Menu Tools > Adjust volume 
 
Esta opcion sirve para configurar tanto el volumen de Reproducción (Playbac ) , Salida de audio del programa. 

omo asi tambien el volumen de Grabacion (Recording) . Entrada de audio al programa. 
 

---------------------------------------------------------------------------------------------------------------------- 
enu View > 

2) Status Bar: Mostrar la barra de estado. 

4) Connection Statistics: Estadisticas de conexión. 
5) Station Summary: Sumario de estaciones. 

 y cuando la otra estacion tenga el 

  
as . 

-------------------------------------------------- ------------------------------------------ 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

----

k
C

--------------------------------------------
M

 
1) Toolbar : Mostrar la barra de herramientas 

3) Large Font: Tamaño mas grande de fuentes. 

6) Alarm log: Log de estaciones conectadas. 
7) DTMF Pad: Activa el Pad DTMF siempre
manejo remoto de su link via DTMF. 
8) Server Message: Mensaje del servidor. 
9) System log: log de movimientos del sistema.
10) Callsign log: log de conexiónes por licenci
 
 
 
 
----------------------------------------------------------------------

 
Barra de Herramientas. 

 

 Transmitir (Barra espaciadora)   Conectar (Alt+C)     Desconectar (Alt+D) 

 Cortar (Ctrl+X)     Copiar (Ctrl+C)     Pegar (Ctrl+V) 

 Refresco de lista (F5)     Información de estacion    Buscar (Ctrl+F) 

 Alarmas (Alt+A)     Herramientas (Alt+E)    Preferencias  

 Ponerme Busy (   Ocupado)  Estadisticas de c   onexión  Sumario de Est. 

 Reproducir archivo aud   io  Stop      Pausa 

 Grabacion      Imprimir      Ayuda 
 



Vista barra de explora o. Mue
canti sta
 
 

 
Listado de estaciones correspondientes a Argentina, muestra el indicativo 
mas la descripción de la misma y/o ubicación geografica.  
 
 
 

 
Cuadro de estado del link con el control 
de volumen del mismo. Figura el 
indicativo, la direccion IP del mismo mas 
el nombre de host. 
Tambien tenemos la barra de estado de 

nido.  

-- --- 
Referencias: 

cion por zona geografica y tipo de nod stra la zona y la 
dad de e ciones entre paréntesis. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

so
 

---------------------------------------------------
 
----------------------------------------------------------------------------------------------------------

 
 
. Sitio web de Echolink, http://www.echolink.org  
. Internet. 

Para ARGCONF, por LU4EGV.Diciembre 2003. 

 
------------------------------------------------------------------------------------------------------------------------------------------------------------------ 
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